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Introduction
This guide describes how to set up and use the features of the Siebel eService for 
Industry Applications that are different from the features of Siebel eService. It is 
meant to be used as a supplement to Siebel eService Administration Guide.

The applications described in this book are:

■ Siebel eBanking

■ Siebel eBrokerage

■ Siebel Insurance eService

■ Siebel eEnrollment for Financial Services

■ Siebel eCustomer for Financial Services

■ Siebel eCommunications, Media, and Energy

■ Siebel eAutomotive
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Introduction

How This Guide Is Organized
How This Guide Is Organized
Each chapter of this book covers a product for a different industry. It covers the 
following topics:

■ Chapter 1, “Siebel eBanking and Siebel eBrokerage”

■ Chapter 2, “Siebel Insurance eService”

■ Chapter 3, “Siebel eEnrollment for Financial Services”

■ Chapter 4, “Siebel eCustomer for Financial Services”

■ Chapter 5, “Siebel eService for eAutomotive”

■ Chapter 6, “Siebel eService for Communications, Media, and Energy”
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Introduction

Revision History
Revision History
Siebel eService Administration Guide Addendum for Industry Applications 

Version 7.5.3

Version 7.5, Rev. A

Table 1. Changes Made in Version 7.5.3 

Topic Revision

Chapter 1, “Siebel eBanking and Siebel 
eBrokerage”

Revised for 7.5.3: Removed information 
about account aggregation. 

Appendix A, “Siebel eBanking Account 
Aggregation Business Components”

Revised for 7.5.3: Removed this appendix.

Table 2. Changes Made in Version 7.5, Rev. A

Topic Revision

“Bill Pay Page for Siebel eBanking and 
eBrokerage” on page 34

Removed information about features that 
are no longer supported, such as prebuilt 
runtime events, workflows, and integration 
objects.
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Siebel eBanking and Siebel eBrokerage 1
Siebel eBanking, a part of Siebel eService, provides a comprehensive online banking 
solution for financial institutions serving consumer and small business customers. 
Siebel eBanking is completely integrated with Siebel eFinance Applications, which 
allows the customer service representative to use a single dashboard for queuing, 
viewing, and resolving customer issues that are submitted through the Web, 
through email, or by telephone.

Siebel eBanking provides multiple means for customers to perform financial 
transactions, inquire about their accounts, and resolve customer service issues on 
their own while providing multiple channels of communication for customers to 
request and receive live support from customer service representatives.

Siebel eBanking provides a personalizable portal supporting a comprehensive list of 
online banking tasks, including:

■ Account inquiry. Customers can gain access to deposit, loan, and brokerage 
accounts, including transactions, holdings, and balance histories.

■ Transactions. Siebel eBanking can serve as the front end for multiple host 
systems. Siebel eBanking handles funds transfers, wire transfers, electronic bill 
payments, and requests for bank drafts.

■ Customer service. Customers can create, track, and resolve customer service 
requests, including ordering statement copies, extra checks and change of 
address requests.

■ Communication capabilities. Customer can use a geocode-based branch locator, 
FAQs, email messaging with the contact center, and Web collaboration.

■ Access control. Siebel eBanking allows for flexible, workflow-driven 
management of password and logon policies.

■ Web architecture. Customers can use customization tools, support for single sign 
on and authentication systems, and integration with existing Web sites.
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Siebel eBanking and Siebel eBrokerage
Siebel eBanking provides these additional features:

■ Web pages, views, and applets are configurable to conform to a customer’s 
business model and the look and feel of your Web site.

■ A salutation applet greets a registered user on login. This applet can be 
configured to contain any targeted content such as promotions, service request 
update information, or a birthday greeting.

■ Contact-based login minimizes the number of database accounts required to 
support all customers receiving Web-based support.

■ Customers have contact-based data visibility, so they see only their own data.

■ Call center agents have a history of each user readily available that is 
independent of the channel of communication the user chooses.
12 Siebel eService Administration Guide Addendum for Industry Applications Version 7.5.3



Siebel eBanking and Siebel eBrokerage

About Siebel eBrokerage
About Siebel eBrokerage
Siebel eBrokerage is a Web-based interface that allows investors to manage their 
brokerage accounts and resolve service issues with brokerage firms. Investors 
include both individual investors and large financial institutions such as pension 
funds, investment funds, and money management groups. Siebel eBrokerage is 
completely integrated with Siebel Financial Services Applications, making it 
possible for a call center agent to use a single dashboard for queuing, viewing, and 
resolving customer issues that are submitted through the Web, email, or telephone. 

NOTE: Siebel eBrokerage is a customized version of Siebel eBanking that contains the 
Relationship page, Trades page, and a customized home page. 

Siebel eBrokerage contains all of the functionality of Siebel eBanking. In addition, 
with Siebel eBrokerage, customers can perform the following self-service activities:

■ Trade stocks, bonds, mutual funds, and options

■ Set up recurring transfers between their banking and brokerage accounts

■ Transfer money by wire

■ Request that a check drawn on their funds be sent to them

■ Perform a full text search of the knowledge base of frequently asked questions 
(FAQs) to help resolve a service issue 

■ Use the Find feature, a query by example, to locate specific service requests or 
FAQs
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Siebel eBanking and Siebel eBrokerage

About Siebel eBrokerage
Siebel eBrokerage provides the following channels for customers to get help from 
call center personnel:

■ A customer can create or update a service request. Documents and lengthy 
descriptions can be attached to help communicate the problem. A service agent 
can update the service request with solutions or documents relating to the 
problem. Workflow policies can be activated to notify a customer by email 
whenever an agent updates a service request.

■ A customer can communicate with service agents by email.

■ A customer can request an immediate virtual meeting with a service agent. 
Siebel eCollaboration allows the customer and agent to share Web pages, 
documents, presentations, or any other desktop imagery in real time. They 
converse by the customer’s preferred channel: telephone, Voice over IP (audible 
speech over the Internet), or text chat (written communication over the 
Internet).

Siebel eBrokerage provides these additional features:

■ Web pages, views, and applets are configurable to conform to a customer’s 
business model and the look and feel of a customer’s Web site.

■ A salutation applet greets a registered user on login. This applet can be 
configured to contain any targeted content such as promotions, service request 
update information, or a birthday greeting.

■ Contact-based login minimizes the number of database accounts required to 
support all customers receiving Web-based support.

■ Business-to-business relationships benefit from the delegated administration 
feature. Registered users with expanded responsibilities can add new users at 
their site, reducing the administrative load at the Siebel eBrokerage host 
company.

■ Customers have contact-based data visibility, so they see only their own data.

■ Call center agents have a history of each user readily available that is 
independent of the channel of communication the user chooses.
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Siebel eBanking and Siebel eBrokerage

Other Differences of Siebel eBanking from Siebel eService
Other Differences of Siebel eBanking from Siebel 
eService

Core functionality not exposed in Siebel eBanking includes:

■ Recommended Products

■ My Account

■ Order Tracking

■ Manage Assets

■ Service Entitlement

■ Anonymous Use

■ Customer Satisfaction Survey

NOTE: Unless noted otherwise, all references to Siebel eBanking are also relevant for 
Siebel eBrokerage.
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Siebel eBanking and Siebel eBrokerage

Administrative Tasks for Siebel eBanking or eBrokerage
Administrative Tasks for Siebel eBanking or eBrokerage
Administrative tasks that are consistent across Siebel Financial Services are covered 
in Siebel eService Administration Guide. The tasks that are specific to Siebel 
eBanking or Siebel eBrokerage for Financial Services are listed in the following 
sections.

■ “Purposes of Siebel eBanking and Siebel eBrokerage” on page 17

■ “Data Display for Siebel eBanking and eBrokerage” on page 18

■ “Service Requests in Siebel eBanking and eBrokerage” on page 19

■ “Personalizing Siebel eBanking and eBrokerage” on page 20
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Siebel eBanking and Siebel eBrokerage

Purposes of Siebel eBanking and Siebel eBrokerage
Purposes of Siebel eBanking and Siebel eBrokerage
Siebel eBanking and Siebel eBrokerage are designed to serve as front-end 
applications to core bank processing systems. Enterprise application integration 
connects the core bank processing systems to the Siebel applications. Table 3 
defines the different purposes of the two applications.

Table 3. Purposes for Siebel eBanking and Siebel eBrokerage

Siebel eBanking Purposes Core Banking System Purposes

Serve as customer relationship 
management system, keeping track of 
customer profiles and interactions.

Serve as system of record for financial accounts 
balances and transactions.

Request data from bank processing 
system and display it to the end user, 
integrating and personalizing it using 
the customer relationship database.

Maintain financial data and provide data to 
Siebel eBanking when requested.

Capture financial transaction requests 
and forward them to bank processing 
system.

Receive, process, and fulfill financial 
transaction requests.
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Siebel eBanking and Siebel eBrokerage

Data Display for Siebel eBanking and eBrokerage
Data Display for Siebel eBanking and eBrokerage
The configurator or system administrator should review the following information 
carefully to make sure the user interface is consistent with your organization's 
standards:

■ Make sure that you search and sort specifications for all applets. Make sure that 
any new data elements defined by your organization are properly displayed in 
existing applets.

■ Make sure that bank processing system integration is in place for all data 
elements displayed to users.

■ Make sure that date and time formats are consistent with the representation of 
such data in the core banking systems.

■ If necessary, configure logic to make sure the display of data is consistent. For 
example, the creation of a funds transfer request in Siebel eBanking and Siebel 
eBrokerage will not automatically modify financial account balances. Only after 
new balances have been reloaded into Siebel eBanking from the bank processing 
system will those values change.

■ Make sure any user interface modifications are compatible with the Internet 
browsers supported by your organization.
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Siebel eBanking and Siebel eBrokerage

Service Requests in Siebel eBanking and eBrokerage
Service Requests in Siebel eBanking and eBrokerage
Siebel eBanking and Siebel eBrokerage allow users to create service requests, such 
as funds transfers, and save the request as a Service Request record. Preconfigured, 
Siebel eBanking and Siebel eBrokerage do not provide prebuilt business logic 
governing the creation of requests, such as limits on data entry or other error 
checking. The following tasks should be performed by the configurator or system 
administrator:

■ Establish appropriate user responsibilities and visibility to provide only 
necessary views, applets, or controls.

■ Review all applets to make sure they display values relevant for your 
organization.

■ Determine and set required fields at both object and user interface levels. 

■ Implement field validation logic. Field validation should be configured using the 
Validation Business Service or by setting object properties in Siebel Tools. For 
more complex logic, server scripting can be employed. Note that Siebel eBanking 
and Siebel eBrokerage are considered standard interactivity applications.

■ Test the configured application, including integration and boundary conditions 
to verify business logic and error messages. The system administrator should 
understand the location of each data element stored during the creation of a 
service request, at both object and database levels.

■ If applicable, confirm that employee users have access to the service request 
data captured in Siebel eBanking and Siebel eBrokerage.

■ If applicable, confirm that service requests created in Siebel eBanking appear to 
the user in the various Service Request list applets.
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Siebel eBanking and Siebel eBrokerage

Personalizing Siebel eBanking and eBrokerage
Personalizing Siebel eBanking and eBrokerage
Using Siebel Personalization (free as part of Siebel installation), you can create 
personalization rules and apply them to applets and views so that each individual 
can view personalized content through these applets and views. For example, you 
can create personalized text messages to alert users to update their user profiles or 
remind them to review their current open service requests. After users update their 
user profiles and review the service requests, the personalized messages disappear 
automatically. The personalization rules can evaluate each user's navigational 
clicks and can render the appropriate text messages and guide them through the 
site.

For more information on setting up and implementing Siebel Personalization, see 
Personalization Administration Guide.
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Siebel eBanking and Siebel eBrokerage

Siebel eBanking and Siebel eBrokerage Pages
Siebel eBanking and Siebel eBrokerage Pages
The following section contains descriptions of each Siebel eBanking page and a 
mapping between the views in the customer application to related views in Siebel 
eFinance (employee application). Note that the view names listed are the display 
names observed by the end user, and are not the view names found in Siebel Tools. 
Procedures related to each page are also described.

When users log in to the Siebel eBanking Web site, the home page appears. 
Registered users see only the tabs appropriate to the responsibilities assigned to 
them.

■ Home. The Salutation applet greets each user with personalized phrasing and 
targeted information. Users can view limited lists of their financial accounts, 
pending payments, existing service requests, and frequently asked questions 
(FAQs). With the Search applet, users can perform full text searches of database 
records to resolve service issues on their own.

■ Accounts. Users can view all of their financial accounts at a particular financial 
institution on one page. They can also access account transaction and 
investment holding details.

■ Transfers. Users can transfer funds between accounts and check completed 
transfers.

■ Bill Pay. Users can schedule one-time or recurring electronic payments, add and 
modify payees, and check pending and completed payments.

■ Customer Service. Users can submit service requests, including statement 
requests, requests for checks drawn on their account, requests for check copies, 
new check orders, stop payment requests, and other problem reports. Users can 
check the status of existing service requests, view or download forms, and view 
frequently asked questions.

■ Relationships (Siebel eBrokerage only). Users can view the list of contacts at their 
bank or brokerage that are assigned to serve them (or the company that they are 
affiliated with), current holdings, securities that they are interested in but do not 
hold, and activities that are being performed for their company.
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Siebel eBanking and Siebel eBrokerage

Siebel eBanking and Siebel eBrokerage Pages
■ Trades (Siebel eBrokerage only). Users can trade stocks, mutual funds, bonds, and 
options. Users can also look up stock symbols, view open orders, and transfer 
assets from other institutions.

■ My Profile hyperlink. Users can edit account nicknames, contact information, and 
passwords.

■ Help hyperlink. Users can get help using the application.

■ Contact Us hyperlink. Users can send messages to service agents, look up the 
nearest branch using Branch Locator, and request a virtual meeting over the Web 
with a service agent

■ Logout hyperlink. Users click the Logout hyperlink to exit the application.
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Siebel eBanking and Siebel eBrokerage

Login Page for Siebel eBanking and eBrokerage
Login Page for Siebel eBanking and eBrokerage
The Login page [FINS eBanking Home Page View (Anonymous)] or FINS 
eBrokerage Home Page View (Anonymous) is displayed to all users when they 
navigate to the Siebel eBanking or Siebel eBrokerage Web site. The status of this 
page as a login view is indicated by the StartCommand reference in the Siebel 
Server’s SWEApp\bin\eapps_sia.cfg file. The login view must be included in the 
responsibilities of both anonymous and registered users.
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Home Page for Siebel eBanking and eBrokerage
Home Page for Siebel eBanking and eBrokerage
After a customer logs in, the home page of Siebel eBanking or Siebel eBrokerage 
appears with a different set of applets. Customers can review their entire 
relationship with their financial institution from this single page.

Table 4 shows a mapping between the views and applets in the customer 
application to the related views in Siebel eFinance (the employee application). The 
view names listed are the display names observed by the end user; they are not the 
view names found in Siebel Tools.

Setting the Display Sequence of Financial Accounts
By default, customers see their financial accounts displayed in administrator-
defined sequences. 

Table 4. Mapping Siebel eBanking to Siebel eFinance for Home Page

Siebel eBanking View Siebel eBanking Applets Related Siebel eFinance Screens

Home Page Salutation Personalization Administration > 
Applets Salutation Applet (Siebel 
eBanking)

Home Page Special Offers, 
Announcements

Campaign Administration > Offers 
and Application Administration > 
System Preferences

Home Page Financial Accounts Financial Accounts Screen

Home Page Pending Payments Contacts > Bill Payment > 
Payments Scheduled

Home Page Service Requests Contacts > Service Requests

Home Page Ask a Question For information about setup and 
implementation of Siebel Smart 
Answer, see Siebel Smart Answer 
Administration Guide
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The administrator assigns a display sequence to each financial product within a 
category of financial products. The categories of financial products are Assets and 
Liabilities. For example, within the Assets category, the administrator can assign 
display sequence 1 to the Savings or MMA product so that accounts of that product 
type display first.

In the Accounts screen’s Summary view, the financial accounts in the Deposits and 
Investments list applet are displayed in the sequence you set for their product types 
in the Assets category. The accounts in the Credit and Loans list applet are displayed 
in the sequence you set for the Liabilities category.

The home page Accounts list applet displays financial accounts in both the Assets 
and Liabilities categories. Accounts are displayed by their sequence number, 
independent of category.

NOTE: Assign separate sequence intervals to categories to group financial accounts 
by category in list applets that include more than one category. For example, you 
could assign sequence numbers 0-99 to products in the Assets category and 
numbers 100-199 to products in the Liabilities category. Assets accounts are then 
displayed before Liability accounts.

If sorting is available for a particular applet that lists financial accounts, customers 
can sort financial accounts alphabetically in ascending or descending order. To 
restore the default sequence, the customer must refresh the page or log out and log 
in again.

To set the default sequence of financial accounts

1 Log in to Siebel eFinance.

2 From the application-level menu, choose View > Site Map > Product 
Administration.

The Product Administration view appears.

3 Click Query.

An empty record appears.

4 From the Type drop-down list, select the type of financial products to sequence. 
You may have to view Columns Displayed to see the Type field.
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5 Click Go.

The products in the queried category appear.

6 Enter a number in the Display Sequence field for the selected product.

You may have to view Columns Displayed to see the Display Sequence field.
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In Siebel eBanking, the term Accounts refers to financial accounts. Accounts can 
include asset accounts and liability accounts. Some types of asset accounts include 
demand deposit (checking), savings and money market, certificates of deposit, and 
investments, among others. Liability accounts include credit cards and loans. 

Financial accounts are customers' instances of financial products. For example, a 
customer's personal savings account has a unique identifying number and is an 
instance of a savings account product offered by a financial institution. For 
information about adding or modifying financial accounts, see Siebel eFinance 
Guide.

Users can drill down on the Account Number to view additional information about 
the transaction history. The user can also download account transactions into a 
spreadsheet application.

Table 5 shows a mapping between the views and applets in the customer 
application to the related views in Siebel eFinance (the employee application). The 
view names listed are the display names observed by the end user; they are not the 
view names found in Siebel Tools.

In addition to the tasks described in Siebel eFinance Guide, additional tasks are 
required for financial accounts to appear in Siebel eBanking. These attributes of the 
financial account and underlying product should be confirmed:

■ The financial account's Status field must be set to Open.

Table 5. Mapping Siebel eBanking to Siebel eFinance for Accounts Page

Siebel eBanking View Siebel eBanking Applets Related Siebel eFinance Screens

Accounts Summary, Asset, 
Liabilities

Financial Accounts screen

Accounts Account Detail Applets Financial Accounts screen

Accounts Transaction History 
Applets

Financial Accounts > Transaction 
Detail or Investment Transactions
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■ Each financial account has an Account Type field. This field is inherited from the 
Type field on the product associated with the account. The Type field can be 
viewed in the Product Administration > More Info view. The product's Type 
must correspond to the filters used in the user interface.

■ Each financial account must be associated with at least one contact, and a 
primary contact should be set.

■ In Siebel eBanking, the Alias field in the FINCORP Account Business Component 
is used to store the account nickname. A nickname is a name defined by the end 
user and set in the Siebel eBanking My Profile screen.

Summary View/Current Balance Summary Applet (FINS eBanking 
Contact Account Balance Form Applet)
The total asset and liability balance fields are calculated in the following manner.

■ The underlying business component queries for all financial accounts where the 
user is a contact on the financial account (user does not have to be the primary 
contact for the financial account).

■ The business component then sums up the asset and liabilities using the 
following criteria:

■ Asset. All accounts where the associated product category = Asset. 

■ Liabilities. All accounts where the associated product category = Liability.

NOTE: The calculation is a simple arithmetic addition of all Current Balance fields 
and assumes that the currency type on all accounts is the same.
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Summary View/Deposits and Investments List Applet
This list contains all financial accounts where the associated product category = 
Asset.

NOTE: The navigation to the Account Detail view is controlled by the Account Type. 
There is one Account Detail view for each Account Type. If you are introducing new 
Account Types, you must also confirm that you have an appropriate Account Detail 
view corresponding to these new Account Types.

Summary View/Credit and Loans List Applet
This list contains all financial accounts where the associated product category = 
Liability.

Account Detail Views/Account Select Applet
This applet provides quick access to all financial accounts held by the user. Note 
that this applet will not function properly if the user is not the primary Contact on 
all financial accounts displayed in Siebel eBanking.

Account Detail Views/Download
Consumers can download account transaction information for any of their accounts 
to a comma-delimited (CSV) file. This type of file can be opened and viewed using 
common spreadsheet applications, as shown in Figure 1.

Before the Download button can be used, you must activate the FINS eBanking 
Account Download Outbound workflow.

Figure 1. Example .csv File Opened in a Spreadsheet Application
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To activate a workflow

1 In Siebel eFinance, navigate to the Business Process Administration Screen.

2 Select the workflow in the Workflow Processes list.

3 Click Revise to make a new version of the workflow.

4 Click Activate.

If you want to configure Siebel eBanking so your customers can download account 
information to other file types, see “Adding Account Download File Types” on 
page 55.
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Siebel eBanking provides the ability to transfer funds between accounts in a variety 
of ways. Funds can be transferred between two accounts with the same institution, 
between institutions, or between institutions through a wire service. All transfers 
except wire transfers can be set up to recur at a specified interval.

From the Transfers page, users can view a history of their transaction, transfer funds 
in or out, or transfer funds to another financial institution.

Table 6 shows a mapping between the views and applets in the customer 
application to the related views in Siebel eFinance (the employee application). The 
view names listed are the display names observed by the end user; they are not the 
view names found in Siebel Tools.

Transferring Funds
By default, error checking is performed on any request created using the FINS 
eBanking Service Request Funds Transfer Form applet. The following checks are 
performed:

■ To Account and From Account field must not be null

■ To Account and From Account cannot be the same value

■ Amount cannot be null, or less or equal to 0

■ Amount cannot exceed the From Account's Current Balance value

Table 6. Mapping Siebel eBanking to Siebel eFinance for Transfers Page

Siebel eBanking View Siebel eBanking Applets Related Siebel eFinance Screens

Funds Transfer Transfer Funds Service > Account Services > Funds 
Transfer

Transfer Money In, 
Transfer Money Out

Transfer Money In, 
Transfer Money Out

Service > Account Services > Auto 
Payment / Saver

Wire Transfer Wire Transfer Service > Account Services > Wire 
Transfer
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In some cases, it may be desirable to disable this error checking or replace the 
checking with a configuration specific to your specific requirements. To do so, the 
configurator should modify the FINS eBanking Service Request Funds Transfer Form 
Applet by setting the ErrorCheck Value applet property to False. 

Transfer Money In/Transfer Money Out Views
The Transfer Money In and Transfer Money Out requests allow the user to use a 
pop-up applet to select a financial institution to transfer funds in and out of. Note 
that the default behavior is to display the identical list of financial institutions for 
both transfer money in and out operations.

Once accounts have been established for the financial institutions that money will 
be transferred to or from, consumers can request a funds transfer into or out of their 
account with the host institution.

To transfer funds into or out of an account

1 From Siebel eBanking or Siebel eBrokerage, click the Transfers tab.

2 Select Transfer Money In or Transfer Money Out.

The Transfer Money In or Transfer Money Out page appears.

3 Click Select in the Transfer From Account or Transfer To Account field.

The Select Account view appears. 

4 If the account you want to use for transferring money is not listed, click New to 
add the account.

5 Complete the fields and click Submit.

The Account Information Confirmation view appears.

6 Click Submit to confirm the account.

The Select Account view appears with the new account added to the list.

7 Select an account from the list.

The Transfer Money In or Transfer Money Out view appears with the account 
selected in the Transfer From or Transfer To Account field.
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8 Complete the remaining fields and click Submit.

A service request is submitted for the funds transfer.
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Electronic bill payment allows customers to pay bills from their home computers. 
Customers can select the accounts that they want to pay, and make single payments 
or automatic recurring payments at any time.

Before customers can use bill payment, they must contact your company so you can 
enroll them in this service, which typically requires a fee.

Siebel eBanking supplies the basic user interface for electronic bill payment, but 
you must complete the configuration and set up integration with a billing service 
provider (BSP) before your customers can use this feature.

There are six actions relating to electronic bill payment that are initiated by either 
the customer or a call center agent at your company. These are: 

■ Enroll

■ Unenroll

■ Add Payee

■ Delete Payee

■ Add Payment

■ Cancel Payment

Enroll and unenroll are performed in Siebel eFinance by a call center agent. The 
other actions are performed by the customer through the Siebel eBanking Web site.

Customer service agents perform the following procedures relating to bill payment:

■ Authorizing an account

■ Enrolling a customer

■ Unenrolling a customer

■ Determining whether a customer is enrolled

■ Reviewing payee setup
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Authorizing and Enrolling a Customer’s Accounts
When a customer calls and asks to be enrolled in your company’s online banking 
system, the call center agent can select (authorize) which accounts can be used for 
online banking before enrolling the customer.

To authorize and enroll a customer’s accounts

1 In Siebel eFinance, navigate to the Service Requests screen.

2 From the Show drop-down list, select All Service Requests.

3 Add a new record in the Service Requests List and complete the necessary fields. 
Some fields are shown in the following table.

4 Click the hyperlink in the SR Number field.

The FIN Service Request Acct Services Bill Pay SignUp View view appears.

5 Click on the Account Services form applet to make it active.

6 Click the select button in the Authorized Account field.

The Financial Accounts dialog box appears. If there are no records in this dialog 
box, make sure that the service request is associated with a contact and that the 
contact is associated with one or more financial accounts.

7 Click the Bill Pay Enable field to place a check in each account for which Bill Pay 
is authorized to draw funds.

8 Click Close.

Unenrolling a Customer
Call center agents can unenroll customers.

Field Value

Type Bank

Area Bill Pay SignUp

Last Name Customer’s last name
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To unenroll a customer

1 In Siebel eFinance, navigate to the Service Requests screen.

2 From the Show drop-down list, select All Service Requests.

3 Select the service request that was used to authorize the customer’s accounts.

4 Click the hyperlink in the SR Number field.

5 From the Show drop-down list, select Bill Pay Log In.

6 Click Unenroll.

Determining Whether a Customer is Enrolled
Call center agents will sometimes need to verify whether a customer is enrolled in 
your company’s electronic bill payment system.

To determine whether a customer is enrolled

1 In Siebel eFinance, navigate to the Contacts screen.

2 In the Contacts list, select the contact.

3 In the Contacts form applet, click the show more button. If the Bill Pay Enrolled 
field is checked, the customer is enrolled.

Reviewing Payees and Payments
Call center agents can review the list of payees that have been selected by the 
customer or the payments that have been scheduled.

To review a contact’s payees

1 In Siebel eFinance, navigate to the Contacts screen.

2 In the Show drop-down list, select All Contacts.

3 In the Contacts list, select a contact.

4 Click the Bill Payment view tab.

The Service Request Acct Services Contact Bill Payees View appears.
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5 In the Show drop-down box, select Payees or Payments Scheduled. Payments 
scheduled can be viewed as a list or chart.
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eBrokerage

A service request is a customer’s request for assistance on products or services they 
have purchased. All service requests include a service request number, a title, a 
description, and a status. 

Examples of service requests include:

■ Requests for financial account statements

■ Requests for check copies

■ Check orders

■ Requests for bank checks

■ Requests to stop payments

■ Other reports of problems

Registered users submit new service requests and check service request status 
through the views in the Customer Service page.

Service requests can be assigned manually to service agents, or an administrator 
can create assignment rules to automatically assign service requests to agents by 
criteria such as product expertise. 

From the Customer Service page, users can ask for assistance on products or 
services they have purchased.
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Table 7 shows a mapping between the views and applets in the customer 
application to the related views in Siebel eFinance (the employee application). The 
view names listed are the display names observed by the end user; they are not the 
view names found in Siebel Tools.

Table 7. Mapping Siebel eBanking to Siebel eFinance for Customer Service Page

Siebel eBanking View Siebel eBanking Applets Related Siebel eFinance Screens

Summary Service Requests Contacts > Service Requests or 
Service screen

Request a Statement Request a Statement Service > Account Services > 
Statement Copy

Request a Check 
Copy

Order a Check Copy Service > Account Services > Check 
Copy Request

Request a Stop 
Payment

Request a Stop Payment Service > Account Services > Stop 
Payment

Order Checks Order Checks Service > Account Services > Check 
Order

Request a Bank 
Check

Request Bank Check Service > Account Services >Bank 
Check

Report a Problem Report a Problem Service screen

Forms Literature Document Administration > 
Literature 

For more information, see “Literature 
Page” on page 59

Frequently Asked 
Questions

Frequently Asked 
Questions

Solution Administration > Solutions

Publish External must be checked
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The Relationship page displays a list of user coverages, holdings, interests, and 
activities. From the Relationship page, users can view their trade history.

Table 8 shows a mapping between the views and applets in the customer 
application to the related views in Siebel eFinance (the employee application). The 
view names listed are the display names observed by the end user; they are not the 
view names found in Siebel Tools.

Adding and Editing Holdings
The Holdings view on the Relationship page displays a list of investments that are 
held by the user's Account. To view or add Holdings, a Contact user must be 
associated with at least one Account, which must be marked as the Primary 
Account. This relationship can be established in the Contacts screen in Siebel 
eFinance.

NOTE: Adding a holding is not the same as making a trade. When a customer adds a 
holding, it is for tracking purposes, and it is not part of their portfolio with the 
institution. If they purchase a security through the Trades page, their portfolio will 
automatically update their holdings accordingly.

To add a holding

1 From Siebel eBanking or Siebel eBrokerage, click the Relationship tab.

Table 8. Mapping Siebel eBrokerage to Siebel eFinance for Relationship Page

Siebel eBrokerage View Siebel eBrokerage Applets Related SIebel eFinance Screens

Relationship Coverage Companies > Coverage Team 
Contacts > Coverage Team

Relationship Holdings Holdings and Interests > Holdings

Relationship Interests Holdings and Interests > Interests 

Relationship Activities Companies > Activities
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2 Click the Holdings hyperlink.

The Holdings view appears.

3 Click Add New Holding. 

The New Holdings view appears.

4 Click Select in the Symbol field.

The Pick Securities view appears.

5 Select a security from the list, or click Search to search for a security if needed.

6 Complete the fields and click Save.

The holding is added to the list.

To edit a holding

1 From Siebel eBanking or Siebel eBrokerage, click the Relationship tab.

2 Click Holdings.

The Holdings view appears.

3 Click the Edit column for the holding you want to edit.

The Edit Holdings view appears.

NOTE: If you click the hyperlink in the Symbol column, detailed information 
about the holding appears.

4 Edit the fields and click Save.

The holding is modified.

NOTE: Only the Customer Estimate, Date of Estimate, Estimate % of Portfolio, 
and Estimate % of Company fields can be modified.
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Adding and Modifying Investment Interests
The Interests view on the Relationship page displays a list of potential investments 
in which the user has expressed interest. 

To add an interest

1 From Siebel eBanking or Siebel eBrokerage, click the Relationship tab.

2 Click Interests.

The Interests view appears.

3 Click Add New Interest.

The New Interests view appears.

4 Click Select in the Symbol field.

The Pick Securities view appears.

5 Select a security from the list, or click Search to search for a security if needed.

6 Complete the fields.

7 Click Save.

The interest is added to the list.

To edit an interest

1 From Siebel eBanking or Siebel eBrokerage, click the Relationship tab.

2 Click Interests.

The Interests view appears.

3 Click the Edit column for the interest you want to edit.

The Edit Interests view appears.

4 Edit the fields. Only the Interest Level, Interest Amount, Interest Type, and 
Interest Price fields can be modified.
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Through the Trades page, users can buy and sell stocks, mutual funds, bonds, and 
options. Also, assets from other institutions can be transferred to user accounts. 
Open orders for stock, bond, mutual fund, and option trades can be viewed and 
canceled.

From the Trades page, users can view their trade history.

In Siebel eFinance, all trades map to the Service Requests screen. There is no direct 
link to the trade or investment views, as an administrator would configure the 
workflow processes to monitor for the Service Requests, and then execute a trade 
from a backend system.

Trade Cancellation
Trade orders can be canceled by drilling down on a trade number from either the 
Siebel eBrokerage Home Page, or the Trades Summary screen. To change default 
trade cancellation behavior, use Siebel Tools to modify the FINS eBrokerage Trade 
Detail Form Applet. The three applet user properties that govern trade cancellation 
behavior are described in Table 9.

Table 9. Applet User Properties for Trade Cancellation

Property Name Default Value Description

Cancel Trade 
Confirm Page 
Sequence

1 This property sets the sequence of the page to 
display for confirming the trade cancellation. 
This number must match the sequence number 
for the page created in Applet Web Templates.

Disable 
DeleteRecord

Y If set to Y, trade cancellation will be enabled for 
all trades with a status of Pending. If set to N 
trades cannot be canceled.

Disable 
DeleteRecord 
GotoView

FINS 
eBrokerage 
Open Orders 
List View

The view to display immediately after the 
cancellation is confirmed.
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Trade Error Checking
When a user enters a trade order, Siebel eBrokerage validates the order information. 
Each type of trade has its own validation rules that are configured in Siebel Tools 
by setting applet user properties for the following applets: 

■ FINS eBrokerage Stock Trade Form Applet

■ FINS eBrokerage Option Trade Form Applet

■ FINS eBrokerage Mutual Fund Sale Form Applet

■ FINS eBrokerage Mutual Fund Purchase Form Applet

■ FINS eBrokerage Bond Trade Form Applet

■ FINS eBrokerage Transfer Securities In Applet
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Table 10 through Table 15 describe the user properties for each of these applets, 
their settings, and the type of error checking that is handled by default when a user 
submits a trade.

Table 10. FINS eBrokerage Stock Trade Form Applet

Property Name Default Value Description

Error Type 1 
Sequence Number

3 This property sets the sequence of the page to 
display if a limit order is entered and limit price 
or stop price is not entered. This number must 
match the sequence number for the page created 
in Applet Web Templates.

Error Type 2 
Sequence Number

4 This property sets the sequence of the page to 
display if an order is entered and all the required 
entry fields are left blank. This number must 
match the sequence number for the page created 
in Applet Web Templates.

Error Type 3 
Sequence Number

5 This property sets the sequence of the page to 
display if a market order is entered and the stop 
price is also entered. This number must match 
the sequence number for the page created in 
Applet Web Templates.

Error Type 4 
Sequence Number

6 This property sets the sequence of the page to 
display if a market order is entered and the limit 
price is entered. This number must match the 
sequence number for the page created in Applet 
Web Templates.

Error Type 5 
Sequence Number

7 This property sets the sequence of the page to 
display if a market order is entered and the limit 
price and stop price is also entered. This number 
must match the sequence number for the page 
created in Applet Web Templates.

FINS eBrokerage 
Type

Stocks Trade This must not be changed.
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Table 11. FINS eBrokerage Option Trade Form Applet

Property Name Default Value Description

Error Type 1 
Sequence Number

3 This property sets the sequence of the page to 
display if an order is entered and any of the 
required fields are left blank. This number must 
match the sequence number for the page created 
in Applet Web Templates.

Error Type 2 
Sequence Number

4 This property sets the sequence of the page to 
display if a limit order is entered and the limit 
price is not entered. This number must match the 
sequence number for the page created in Applet 
Web Templates.

Error Type 3 
Sequence Number

5 This property sets the sequence of the page to 
display if a market order is entered and the limit 
price is also entered. This number must match 
the sequence number for the page created in 
Applet Web Templates.

FINS eBrokerage 
Type

Options Trade This must not be changed.

Table 12. FINS eBrokerage Mutual Fund Sale Form Applet

Property Name Default Value Description

Error Type 1 
Sequence Number

3 This property sets the sequence of the page to 
display if an order is entered and any of the 
required fields are left blank. This number must 
match the sequence number for the page created 
in Applet Web Templates.

FINS eBrokerage 
Type

Mutual Fund 
Sale

This must not be changed.
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Table 13. FINS eBrokerage Mutual Fund Purchase Form Applet

Property Name Default Value Description

Error Type 1 
Sequence Number

3 This property sets the sequence of the page to 
display if an order is entered and any of the 
required fields are left blank. This number must 
match the sequence number for the page created 
in Applet Web Templates.

FINS eBrokerage 
Type

Mutual Fund 
Purchase

This must not be changed.

Table 14. FINS eBrokerage Bond Trade Form Applet

Property Name Default Value Description

Error Type 1 
Sequence Number

3 This property sets the sequence of the page to 
display if an order is entered and any of the 
required fields are left blank. This number must 
match the sequence number for the page created 
in Applet Web Templates.

Error Type 2 
Sequence Number

4 This property sets the sequence of the page to 
display if a limit order is entered and the limit 
price is not entered. This number must match the 
sequence number for the page created in Applet 
Web Templates.

Error Type 3 
Sequence Number

5 This property sets the sequence of the page to 
display if a market order is entered and the limit 
price is also entered. This number must match 
the sequence number for the page created in 
Applet Web Templates.

FINS eBrokerage 
Type

Bonds Trade This must not be changed.
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If the error checking described in these tables is insufficient, the Siebel 
administrator can use VB Script or Siebel eScript to further customize trade order 
error checking. For more information, see Siebel Tools Reference or Siebel Tools 
Online Help. 

Table 15. FINS eBrokerage Transfer Securities In Applet

Property Name Default Value Description

Error Type 1 
Sequence Number

3 This property sets the sequence of the page to 
display if both the entire and partial account 
transfer is chosen. This number must match the 
sequence number for the page created in Applet 
Web Templates.

Error Type 2 
Sequence Number

4 This property sets the sequence of the page to 
display if neither entire or partial account transfer 
is being chosen. This number must match the 
sequence number for the page created in Applet 
Web Templates.

FINS eBrokerage 
Type

Bonds Trade This must not be changed.
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My Profile Screen for Siebel eBanking and eBrokerage
Customers maintain personal profile information by clicking Profile from any page. 
They can add or modify contact preferences, contact addresses, financial account 
nicknames, and login password. Default contact preferences include phone 
numbers, email address, best time to call, and preferred language.

Table 16 shows a mapping between the views and applets in the customer 
application to the related views in Siebel eFinance (the employee application). The 
view names listed are the display names observed by the end user; they are not the 
view names found in Siebel Tools.

On the My Profile screen, note the following:

■ Contact preference changes are written directly to the customer’s contact record.

■ Added or modified addresses are logged as service requests of Type = Bank and 
Area = Customer Address.

Table 16. Mapping Siebel eBanking to Siebel eFinance for My Profiles Screen

Siebel eBanking View Siebel eBanking Applets Related Siebel eFinance Screens

User Profile User Profile Contacts screen

Address Book Addresses Contacts screen

Subscriber 
Preferences

Subscriber Preferences Contact screen (note that not all 
fields are visible in Siebel eFinance)

Account Nicknames Account Nicknames No corresponding view exists in 
Siebel eFinance for this data.
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■ Account nicknames appear in account list applets. A financial account’s 
nickname is the Alias field value in the FINCORP Account business component 
instance for the financial account.

NOTE: Account nicknames can be provided for customers by initializing the Alias 
field with the Product name when an account is created. A new account then 
always displays a name in the Account Nickname field. You can automate this task 
using Siebel Business Process Designer or Siebel Enterprise Integration Manager.

For information about administering login usernames and passwords, see the 
section on user access in this guide. 

For information about automating data import tasks, see Siebel Enterprise 
Integration Manager Administration Guide.
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About Account Download in Siebel eBanking and 
eBrokerage

The preconfigured Siebel eBanking and eBrokerage applications allow your 
customers to download account information to a comma-delimited file that can be 
opened in a spreadsheet application. If you want your customers to be able to 
download account data to other file types, you will need to configure Siebel 
eBanking.

This section explains how account download works in the preconfigured 
application. Understanding this will make it easier for you to design your 
configuration.

Overall Process
The method that the customer follows to initiate an account download is slightly 
different for brokerage accounts and other accounts.

■ Brokerage Accounts. The customer selects a brokerage account in Siebel 
eBrokerage and clicks the Download button on the Investment Transactions 
applet. A File Download dialog box opens asking whether the customer wants 
to open or save the file. The customer selects Save this file to disk, clicks OK, 
and follows the Save As dialog box to download a CSV file containing 
investment transaction records.

■ Other Accounts. The customer selects a nonbrokerage account in Siebel eBanking 
or Siebel eBrokerage and clicks the Download button on the Recent Transactions 
applet. In the Account Download applet, the customer enters the starting and 
ending dates for the transaction data and selects the CSV file format. The 
selected dates are used as the search specification for the query. If the customer 
has performed an account download on this account before, the start date will 
be predefaulted to the end date of the last download. If no dates are selected, all 
of the transaction data is downloaded for the account period between the last 
time data was downloaded and the present. If no file format is selected, the data 
output is in the form of a Siebel message, which is an XML-formatted message 
that describes Siebel data. When the customer clicks the Download button, the 
search specification is sent to the FINS eBanking Account Download Outbound 
workflow, which then begins.
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During the workflow process, a query is used to export the requested data to an 
instance of a source integration object that uses Siebel format. The Data 
Transformation Engine converts the data to a format that is consistent with the CSV 
format and stores it in an instance of a target integration object. The workflow 
passes the data back to the Account Download applet in the form of a text string. 
The applet then prompts the user’s Web browser to save the text string as a file on 
the customer’s computer.

Workflow Details
The FINS eBanking Account Download Outbound workflow is shown in Figure 2.

Figure 2. FINS eBanking Account Download Outbound Workflow
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The actions performed by the workflow are summarized in Table 17.

Table 17. FINS eBanking Account Download Outbound Workflow Actions

Step Action

Start ■ If the Download button is clicked with no active record (no row Id 
for the business object’s primary business component) the 
workflow ends.

■ If the selected file format is CSV, the lower path of the workflow is 
followed. 

■ If the selected file format is not CSV, the upper path of the 
workflow is followed.

Prepare CSV ■ Specifies FINSAcctDlCSVMapOut as the data map used by the 
Data Transformation Engine to map Siebel data to the target data 
format.

■ Specifies FINS eBanking Account Download CSV Interface as the 
target integration object that stores the data after data 
transformation.

CSV - Get Acct 
Txn Info

EAI Siebel Adapter queries the database for the transaction data 
between the starting and ending dates specified by the customer. The 
data is stored in memory as an instance of the FINS eBanking Account 
Download Internal source integration object in Siebel format.

CSV - DTE The Execute method of the EAI Data Mapping Engine business service 
moves the data in the FINS eBanking Account Download Internal 
integration object to the FINS eBanking Account Download CSV 
integration object, according to the mapping in the 
FINSAcctDlCSVMapOut data map.

CSV - IntObj To 
XML Hier

The EAI Integration Object to XML Hierarchy Converter is used to 
convert the Siebel format to XML by flattening the data hierarchy and 
removing unneeded metadata tags.

CSV - Convert to 
Document

The FINS EAI Free Format Hier Converter converts the XML data to 
the text string that is returned to the Account Download applet. Input 
arguments in this step are selected to define the format of the output.  
Optionally, the administrator may add an input parameter to set the 
user property XMLFormatting of the business service FINS EAI Free 
Format Hier Converter. By default, this property is False, which 
implies that text is retained in its original format. When set to True, 
XML conventions for text handling are used; for example, apostrophes 
are encoded as &apos; and < is replaced with &lt;.
Version 7.5.3 Siebel eService Administration Guide Addendum for Industry Applications 53



Siebel eBanking and Siebel eBrokerage

About Account Download in Siebel eBanking and eBrokerage
The upper path in the workflow, which includes the Get Acct Txn Info and Convert 
to XML Document steps, is not used in the preconfigured Siebel eBanking 
application. However, you could configure the application so that the workflow is 
triggered in a way that does not eliminate the possibility that no active record is 
selected. In this case, the top path would be used to bypass steps that might cause 
unwanted behavior.
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If you want your customers to be able to download account data to other file types, 
apart from comma-delimited files, you will need to configure Siebel eBanking.

The general process for this configuration is:

1 Add a new value to the File Format drop-down list. 

2 Create an integration object to store data in the format of the new file type.

3 Create the data map between the Siebel format integration object and the target 
integration object created in Step 2.

4 Add a new branch to the FINS eBanking Account Download Outbound 
workflow.

More details are given for each of these steps later in this section.

Adding a New Value to the File Format Drop-Down List
You must add a new value to the File Format drop-down list that appears in the 
Siebel eBanking Account Download applet.

To add a new value to the File Format drop-down list

1 Navigate to the Application Administration screen.

2 From the Show drop-down list, select List of Values.

3 In the List of Values list, query for ACCTDL_FILE_TYPE.

4 Add a new record, and complete the fields in the following table:

Field Value

Active Select the check box

Display Value The name of the file type that you want to 
appear in the File Format drop-down list

Language-Independent Code Can be the same as the Display Value. 
This value is used for conditional 
branching
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5 Click the menu button and select Save Record.

For more information about lists of values, see Applications Administration Guide.

Creating an Integration Object for the New File Type
You must create an integration object that describes the format of the new file type 
(the target format) in Siebel Tools. If you have the DTD (Document Type Definition) 
file of the target data format, you can use the DTD Wizard in Siebel Tools to build 
this integration object.

For more information about creating integration objects, see Siebel Tools Reference.

Creating the Data Map
You must create a data map record and then use the Siebel Data Map Editor to create 
the map that is used by the Data Transformation Engine to change the format and 
hierarchy of the Siebel format source integration object instance to that of the target 
integration object instance. Data map records are created in the Data Map view of 
the Integration Administration screen. The data mapping is performed in the Data 
Map Editor view of the Integration Administration Screen.

For detailed information about how to create data maps, see Business Processes and 
Rules: Siebel eBusiness Application Integration Volume IV.

Modifying the Workflow
You must create a new path from the Start step of the FINS eBanking Account 
Download Outbound workflow for each new file format that you want to support. 
The relevant steps should reference the target integration object and data map that 
you create.

Language Name English-American

Replication Level All

Translate Clear the check box if it is selected

Type ACCTDL_FILE_TYPE

Field Value
56 Siebel eService Administration Guide Addendum for Industry Applications Version 7.5.3



Siebel Insurance eService 2
Siebel Insurance eService is a Web site through which customers can resolve service 
issues and view information related to their insurance policies. Some features 
described in this chapter are only available to you if your company has also licensed 
Siebel eInsurance or Siebel eHealthcare product options.

Siebel Insurance eService provides customers with the ability to:

■ View policy data.

■ Submit service requests, attaching supporting documents if needed.

■ Report and check the status of insurance claims.

■ View and download forms.

■ View the current cash value of policies.

■ Search for and change healthcare providers.

■ Perform a full text search of the knowledge base of frequently asked questions 
(FAQs) to help resolve a service issue.

■ Use the Find feature, a query by example, to locate specific service requests or 
FAQs.

■ Submit a customer satisfaction survey to give feedback about the service they 
have received.

■ Send an email to a service agents.

■ Request an immediate virtual meeting with a service agent using Siebel 
eCollaboration.

■ Register for health-related classes.

■ Locate health clubs that provide discounts for members of health plans.
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■ Find out whether a particular drug is covered by their health plan policy.

■ Locate affiliated pharmacies.

■ Research drug interaction information.

■ Locate affiliated businesses that will perform work related to an insurance claim.

Siebel Insurance eService provides these additional features:

■ Roles, which allow different customers to see different applets on the Siebel 
Insurance eService Web site.

■ Web pages, views, and applets which can be configured to conform to your 
business model.

■ A salutation applet that greets a registered user on login. This applet can be 
configured to contain any targeted content such as promotions, service request 
update information, or a birthday greeting.

■ Contact-based login, which minimizes the number of database accounts 
required to support all customers receiving Web-based support.

■ Contact-based data visibility for customers, so they see only their own or their 
own household’s data.

■ A history of each user that is readily available to the service agent and which is 
independent of the channel of communication the user chooses.
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Siebel Insurance eService User Interface Features
This section describes the user interface features that are available in Siebel 
Insurance eService. For the administrative tasks you will need to perform to set up 
the Web site, see “Administrative Tasks for Siebel Insurance eService” on page 63.

Siebel Insurance eService includes the following user interface features.

Home Page 
When a customer first opens the Siebel Insurance eService Web site, the Home page 
that appears includes a login applet. If you decide to implement roles, customers 
who have been assigned different roles will see different applets after they log in.

The Salutation applet greets each customer with personalized phrasing and targeted 
information. Customers can view and access their personal policies, their group 
benefits, and frequently asked questions (FAQs). With the Search applet here and 
on most screens, customers can perform full text searches of database records to 
resolve service issues on their own.

Literature Page
From the Literature page, users can search for and use insurance related literature 
such as pamphlets and brochures.

A form must meet the following requirements to be displayed in the Literature view 
or to be a result of a search using the Find Form applet:

■ It must reside in the Siebel file system.

■ Its record in the Literature table must have an Internal field value of FALSE, thus 
allowing external publication.

■ Its record in the Literature table must have a Literature Type field value of Self-
Service Form.

It must be associated with the organization to which the Web site visitor is 
associated, that is, the organization of the proxy employee through which the user 
gets data visibility.
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eEvents Page
Customers can view information about future events such as health-related 
seminars on the eEvents page.

Personal Policies List
A personal policy is a contract of insurance with an individual, as opposed to a 
group. Examples are your personal life insurance policy or your individual health 
insurance policy. A policy is visible to all contacts listed on the policy, both primary 
insureds and others.

From the Personal Policy/Quotes list, members can:

■ Check the insureds on their policies

■ View coverage details of their policies

■ View primary care provider profiles

■ Search for and view profiles of care providers

■ Change primary care providers

■ Check the status of service requests

■ Find the current cash value of their life insurance policies

■ Submit requests for withdrawals from their life insurance policies

■ View and request loans against their life insurance policies

■ View and request financial transfers relating to their life insurance policies

■ Submit service requests

■ View driver and vehicle information

■ Report a claim
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Group Benefits List
A group policy is a contract with a group to provide insurance to its members. 
Usually the group is an employer and the members are its employees. Once a group 
policy is established, employees can opt to be covered by the policy by enrolling. 
Once enrolled, the employees are commonly known as members. 

Types of group insurance include group health insurance, group life insurance, and 
others. Group insurance is often offered to employees through an employer group, 
so group benefits is often used interchangeably with group insurance.

Members can perform the following tasks with their group policies:

■ Check the members on their policies

■ View eligibility and benefits information

■ View primary care provider profiles

■ Search for and view profiles of care providers

■ Change primary care providers

■ Check the status of service requests

■ Submit service requests

NOTE: A policy is visible to all contacts listed on the policy, both primary insureds 
and others. An exception to this is when a person is a primary member of a group 
policy but is not an insured member. This person cannot see the policy.

Claims List 
Customers can check the status of existing claims and report new claims from a 
Siebel Insurance eService Web site. Claims are reported and viewed by clicking the 
View Claims and Claim Payments hyperlink.

Service Requests
Customers can submit service requests, check the status of existing service 
requests, submit a customer satisfaction survey, and view frequently asked 
questions.
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Contact Us Hyperlink
Customers can send messages to service agents, read messages from service agents, 
and request a virtual meeting over the Web with a service agent.

My Profile Hyperlink
Customers can edit contact information and passwords by clicking the My Profile 
hyperlink.
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Administrative Tasks for Siebel Insurance eService
Administrative tasks that are consistent across Siebel Financial Services are covered 
in Siebel eService Administration Guide. Tasks that are specific to Siebel Insurance 
eService for Financial Services are listed in the following sections:

■ “Creating Roles for Siebel Insurance eService” on page 64

■ “Setting Up Provider Search for Siebel Insurance eService” on page 66

■ “Setting Up Classes and Seminars for Siebel Insurance eService” on page 68

■ “Setting Up Health Club Discounts” on page 69

■ “Setting Up Alternative Medicine Search” on page 70

■ “Setting Up Pharmacy Locator” on page 71

■ “Setting Up Formulary Search” on page 72

■ “Setting Up a Link To Drug Interactions Information” on page 73

■ “Displaying Auto Policy Coverage Comparisons” on page 74

■ “Setting Up Printable Online Documents for Siebel Insurance eService” on 
page 75

■ “Administering Partner and Claim Center Locators” on page 76

■ “Setting Up Service Provider Search” on page 77
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You can use roles to:

■ Control the pages and applets that different customers see when they log in to 
your Siebel eService Web site.

■ Guide customers in performing tasks that are relevant to them. This is done by 
providing a task applet on the home page that has links to the places on the Web 
site where the customer can complete the tasks. Customers with different roles 
see different task lists.

Siebel Insurance eService has two preconfigured roles, which are used to create 
roles-based home pages:

■ Healthcare Member. Users with the Healthcare Member role will see the Health & 
Wellness Services applet and the Pharmacy Services applet on the home page. 
They also see healthcare-specific task links in the Customer Services applet.

■ Insurance Member. Users with the Insurance Member role will see the Contact Us 
applet and the Service Your Policy applet on the home page. They also see 
insurance-specific task links in the Customer Services applet.

Set up roles in your Siebel Financial Services employee application. The general 
steps for setting up a role, along with information specific to Siebel Insurance 
eService, are given below. Detailed directions for setting up a new role are given in 
Security Guide for Siebel eBusiness Applications.

1 Create a role record. Create a role record in the Roles list of the Group 
Administration screen.

2 Create tasks for the role. For each task that you want to appear in the task applet 
on the home page, create a record that is associated with the role record. Make 
sure that you use the value Home Page Tasks for the Group field.
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3 Select applets to display using personalization. To make an applet display for a user 
who has a particular role, set a conditional expression for the applet in the 
Personalization Administration screen. As an example, for the applet FINS FSW 
Health Wellness Center Links Applet, the conditional expression is 
GetProfileAttr ("Primary User Role Name") <> 'Insurance Member'. This 
means that users with the Insurance Member role will not see this applet.

You can obtain a list of the applets that are associated with the Insurance 
Member and Healthcare Member roles by querying for the word Member in the 
Conditional Expression field of the Applets list.

4 Assign users to roles. Assign users to the new role through the User 
Administration screen of your employee application. When users log in, they 
will only see information specific to their role.
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A user with the role of Healthcare Member can search for providers contracting with 
the health plan by clicking the Provider Search hyperlink in the Customer Services 
applet, selecting the enrolled product, and clicking the Find Provider icon. The 
customer sets search criteria such as specialty or location. The result list includes 
providers that fit all of the criteria.

Only providers in the database that are listed as contracted providers for a health 
product are included in the list of providers or in the provider search list for that 
product.

Criteria that customers enter into text fields should not use quotes. Text strings in a 
field can use AND, OR, or NOT as connectors. Criteria can contain wildcards. The 
asterisk (*) is a wildcard for any string, and the question mark (?) is a wildcard for 
any character. For example, searching on dat* will return records containing date, 
database, data source, and so on. Searching on dat? finds records containing date, 
data, and so on.

The detailed procedures for setting up provider search are given in Siebel 
eHealthcare Guide. The main steps are summarized here, with the addition of 
information specific to Siebel Insurance eService. 

1 Add a provider. Add a provider in the Providers screen of your Siebel Financial 
Services employee application.

2 Add addresses. Add one or more addresses for the provider in the Addresses view 
of the Providers screen and click Update Geo Code. If geocode data has been 
entered in the Zip Code Administration view of the Application Administration 
screen, the longitude and latitude information will be automatically entered.

3 Associate products. Add one or more contracted products for the provider in the 
Contracts view of the Providers screen.
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4 Associate specialty. Add a specialty for the provider in the Specialties view of the 
Providers screen.

If you want to add a new type of specialty, you must add a new List of Values 
record with the Type = FINS_AGDESG_HLTHSPEC_MLOV. For the Order field, 
select a value between 60–155 for it to display in the Specialty drop-down list. 
A search specification is set in Siebel Tools for the associated picklist (FINS 
PickList Health Provider/Facility Specialty).
Version 7.5.3 Siebel eService Administration Guide Addendum for Industry Applications 67



Siebel Insurance eService

Setting Up Classes and Seminars for Siebel Insurance eService
Setting Up Classes and Seminars for Siebel Insurance 
eService

The Health & Wellness Services applet of Siebel Insurance eService has a Classes 
and Seminars hyperlink that users with the role of Healthcare Member can click to 
learn about and register for upcoming events. Only future events are listed in the 
Upcoming Events applet on the Web site.

NOTE: A license for Siebel eEvents is required for this functionality.

To create a class or seminar event

1 In your Siebel Financial Services employee application, navigate to the Events 
screen.

2 From the Show drop-down list, select All Events.

3 Create a new event record, completing all the required fields and making sure 
that you place a check mark in the External field.

4 Click Save.

5 Click the Sub-Events view tab.

You will see that subevents are automatically created based on the value you 
selected for the Sub-Event Frequency field, and the Start and End dates.

6 In the Sub-Events list, click a hyperlink in the Name field.

7 Enter the appropriate details for each subevent into the More Info form.

Make sure that you select either In Progress or Executing for the Status field.

8 Click Save.

For more information about creating events, see Siebel eEvents Management Guide 
for Financial Services.
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Setting Up Health Club Discounts 
The Health & Wellness Services applet of Siebel Insurance eService has a Health 
Club Discounts hyperlink that users with the role of Healthcare Member can click 
to see a list of local health clubs that have reduced rates for members of the 
healthcare plan.

To set up a healthcare discount

1 In your Siebel Financial Services employee application, navigate to the 
Campaign Administration screen.

2 Add a record, complete the necessary fields, and make sure that you use Health 
Club Discount for the Name field. 

For more information about creating a campaign, see Siebel Marketing Guide.

3 Save the record.

4 Navigate to the Application Administration screen.

5 From the Show drop-down list, select System Preferences.

6 In the System Preferences Name field, query for *Campaign.

7 Verify that the INSeService Discount Campaign has a System Preference Value of 
Health Club Discount.

8 Navigate to the Offers screen.

9 In the All Offers list, add a record and complete the necessary fields, making sure 
that you select Web-Announcements for the Type field and enter a description 
of the offer.

10 In the Campaign Administration screen, select the campaign that you defined in 
Step 2, and in the Offer’s list add the offers that you defined in Step 9.

For more information about creating offers, see Siebel Marketing Guide.
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Setting Up Alternative Medicine Search
The Health & Wellness Services applet of Siebel Insurance eService has an 
Alternative Medicine Search hyperlink that users with the role of Healthcare 
Member can click to find healthcare providers who practice alternative medicine. 
This feature uses a version of the Provider Locator.

For information about adding a specialty to the list of values, see Step 4 on page 67.

For more information, see “Setting Up Provider Search for Siebel Insurance 
eService” on page 66.
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Setting Up Pharmacy Locator
The Pharmacy Services applet of Siebel Insurance eService has a Pharmacy Locator 
hyperlink that users with the role of Healthcare Member can click to search for a 
local, affiliated pharmacy.

To add a pharmacy to the list of affiliated pharmacies

1 In your Siebel Financial Services employee application, navigate to the Facilities 
screen.

2 From the Show drop-down list, select All Facilities.

3 In the Facilities list, add a record and complete the necessary fields, making sure 
that you select Pharmacy in the Type field and enter the address in the Primary 
Address field.

4 Save the record.

5 In the Locations list, add a record, provide a Location Name, and in the Address 
field, select the address that you entered in Step 3.

6 If the Longitude and Latitude values are not automatically populated, set them 
in the Zip Code Administration view of the Application Administration screen.
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Setting Up Formulary Search
The Pharmacy Services applet of Siebel Insurance eService has a Formulary Search 
hyperlink that users with the role of Healthcare Member can click to find out 
whether a particular drug is listed in the formulary of their health insurance plan. 
If it is listed, the customer’s insurance will cover some or all of the cost of the drug. 
The formulary is a document that the customer can read or search.

When the customer clicks the Formulary Search link, the formulary search applet 
opens, listing one or more formulary documents. The customer clicks the hyperlink 
for the appropriate formulary and is given the choice of downloading or opening 
the document. Once it is opened, the customer can search the document for the 
drug they are interested in.

To set up formulary search

1 In your Siebel Financial Services employee application, navigate to the 
Document Administration screen.

2 From the Show drop-down list, select Literature.

3 Add a record and complete the necessary fields, making sure that you select 
Formulary Literature for the Type field.

4 Save the record.

For more information about working with literature, see Applications 
Administration Guide.
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Setting Up a Link To Drug Interactions Information
The Pharmacy Services applet of Siebel Insurance eService has a Drug Interactions 
hyperlink that customers with the role of Healthcare Member can click to open a 
Web site that contains information about drug interactions. The preconfigured 
Siebel Insurance eService application has a link to the United States’ Centers for 
Disease Control and Prevention Web site.

To set the link to a drug interaction Web site

1 In Siebel Tools, select Applet in the Object Explorer.

2 Select FINS FSW Pharmacy Center Links Applet.

3 Click Control in the Object Explorer.

4 Select the ImageDrug record.

5 Click Control User Prop in the Object Explorer.

6 Set the Value field to the URL of the Web site you want to open when the link is 
clicked.

7 Click Control in the Object Explorer.

8 Repeat Step 3 through Step 6 for the LinkDrug control.
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Displaying Auto Policy Coverage Comparisons
In the Coverage and Premium applet of Siebel Insurance eService, customers can 
see a side-by-side comparison of the insurance premiums and coverage for each of 
their vehicles.

The information displayed in this applet is the same as the information displayed in 
the Multi Vehicle Rate Model view form of the Auto Policies screen of your Siebel 
Financial Services application. The information is added when the employee creates 
new auto policy records.

For more information about creating auto policies, see Siebel eInsurance Guide.
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Setting Up Printable Online Documents for Siebel 
Insurance eService 

You can display policy documents on your Siebel Insurance eService Web site to 
customers who have the role of Insurance Member.

To display an auto policy document, the customer selects the View Personal Policies 
hyperlink on the home page and clicks the hyperlink for the auto policy. In the Auto 
Policy applet, the customer clicks the Documents Online hyperlink and a list of auto 
policy documents is displayed. In the Property policy applet the customer clicks the 
Documents Online hyperlink and a list of property policy documents is displayed.

Auto and property policy documents are reports created with Siebel Reports Server. 
To set up this feature, you must enable Siebel Report server for the Insurance 
eService Object Manager (ENU) server component.

For information about how to enable Siebel Reports Server for the Web Client, see 
Siebel Reports Administration Guide.
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The Contact Us applet on the home page of Siebel eInsurance has a Locate Nearby 
Partners hyperlink and a Locate Nearby Claims Centers hyperlink. When users with 
the role of Insurance Member click one of these links, an applet opens in which they 
can perform a parametric search using location attributes that they select from drop-
down lists.

For information about how to administer the records used in these searches, see 
Siebel eInsurance Guide.
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When creating a self-service claim on a Siebel Insurance eService Web site, a 
customer can search for a partner business that can rectify the problem relating to 
the claim. Businesses might include auto body repair shops and electricial 
contracting companies. The service provider search is based on the Siebel Partner 
Locator.

To create a claim, the customer clicks the View Claims and Payments hyperlink in 
the Customer Services applet of the home page. The customer clicks the New button 
in the Claims applet, completes the necessary fields, and clicks the select button in 
the Pick Service Provider field. The customer then follows the directions on the 
Service Providers applet and a list of partner service providers is displayed. 

Detailed procedures for how to create a service provider are given in Siebel Partner 
Relationship Management Administration Guide. The main steps are summarized 
here, with the addition of information specific to Siebel Insurance eService.

1 Add a partner. In your Siebel Financial Services employee application, navigate 
to the Partners screen, add a record, and complete the necessary fields, making 
sure that you:

■ Complete the Address field.

■ Select Service Provider for the Partner Type field.

■ Check the Primary check box when selecting the partner type.

2 Add a location. For the new partner record, add a location record in the Locations 
list, selecting the address that you entered in Step 1.

3 Associate an expertise. For the new partner record, select a value for the Expertise 
field in the Profile form, and enter other information as required.

4 Approve the partner. In the Partner Administration screen, from the Show drop-
down list, select Approved Partners. Select the partner record that you added and 
click Register. Select the Organization check box, and click Save.
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The following procedures demonstrate how a customer might use your Siebel 
Insurance eService Web site.

To view personal policy information

1 In the customer services applet of the Siebel Insurance eService Web site, click 
the View Personal Policies hyperlink.

2 Identify the policy that you want to view and click on the link in the Policy #/
Quote # field.

3 Click different links in the applet on the left of the page to see detailed 
information.

The name of the applet changes depending on the selected policy.

To view information about providers

1 In the Customer Services applet, click the View Personal Policies hyperlink.

If the link is not visible, see “Creating Roles for Siebel Insurance eService” on 
page 64.

2 In the Personal Policies/Quotes applet, locate the policy record with Health 
Quote in the Type field.

3 Click the hyperlink for the record in the Policy#/Quote# field.

4 In the All Benefits for My Household list, click the hyperlink in the Primary Care 
Provider field.

The Provider Profile applet opens with information about the provider.

To change primary care provider (HMO only)

1 In the Customer Services applet, click the Change PCP hyperlink.

2 In the Benefits list, click the search icon in the Change Primary Care Provider 
field for the product that you are interested in.
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3 Click the edit icon in the Select Primary Care Provider field for the provider that 
you want to change to.

A note appears telling you that you have changed your provider and the new 
primary care provider appears in the All Benefits for My Household list applet 
for the applicable household member.

To view group benefit information

1 In the Customer Services applet, click the View Group Policies hyperlink.

2 In the Group Benefits list, click the link in the Group #/Policy # field for a policy.

Information about the household’s benefits is shown.
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Siebel eEnrollment is a Web-based interface that allows group members to enroll 
themselves and family members in health coverage available under their group’s 
health policy over the Internet.

Siebel eEnrollment provides group members with the following self-service 
capabilities:

■ Enrollment. New and current members are guided through an enrollment process 
based on their status as a new or current member. Current members can view 
existing coverage and elect to remain under current coverage, or they can change 
coverage options. Normally, group members can enroll for coverage through 
Siebel eEnrollment only during designated enrollment periods such as when 
they join the company, or during open enrollment. 

■ Personal Profile Management. Group members can update information such as 
name, address, and telephone number for themselves, family members, or their 
broker.

■ Provider search and assignment. Group members can search a directory of eligible 
primary care physicians (PCPs) or physicians within their network. They can 
add a PCP to their coverage selections at the time of enrollment. PCP searches 
can be performed using a number of criteria including specialty, language 
spoken, and location. 

■ Beneficiary designation. Group members can select 401k benefits and add 
beneficiaries.
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Administrative Tasks for Siebel eEnrollment for Financial 
Services

There are certain administrative tasks that are consistent across Siebel Financial 
Services, and many of these screens are covered in Siebel eService Administration 
Guide. The tasks that are specific to Siebel eEnrollment for Financial Services are 
listed in the following section: 

■ “Setting Up Provider Search for Siebel eEnrollment for Financial Services” on 
page 83
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Setting Up Provider Search for Siebel eEnrollment for 
Financial Services

A member of a health plan can search for providers who contract with the health 
plan that fit user-defined criteria, such as specialty or locale. The member can 
specify one or more criteria. The result list includes providers that fit all of the 
criteria.

Only providers in the database that are listed as contracted providers for a member’s 
health product are included in the list of providers or in the provider search list for 
that product.

Search criteria can be entered in one or more of the ten fields in the Find Provider 
form applet. The search results include all providers that fit all the criteria.

Text fields in the Find Provider form applet include First Name, Last Name, Street 
Address, City, and Postal Code. 

Criteria in text fields should not use quotes. Text strings in a field can use AND, OR, 
or NOT as connectors. Criteria can contain wildcards. The asterisk (*) is a wildcard 
for any string, and the question mark (?) is a wildcard for any character. For 
example, searching on dat* will return records containing date, database, data 
source, and so on. Searching on dat? finds records containing date, data, and so on.
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Fields in the Find Provider form applet are populated by the lists of values in 
Table 18.

For information about modifying a list of values, see Applications Administration 
Guide.

Table 18. Find Provider Form Fields

Field List of Values Type

Primary Specialty FINS_HLTH_SPECIALTY

All Specialties FINS_HLTH_SPECIALTY

State STATE_ABBREV

Country COUNTRY

Panel Status FINS_HLTH_PANEL
84 Siebel eService Administration Guide Addendum for Industry Applications Version 7.5.3



Siebel eEnrollment for Financial Services

Siebel eEnrollment for Financial Services User Interface Elements
Siebel eEnrollment for Financial Services User Interface 
Elements

In Siebel eEnrollment, users can access the following pages and utilities.

■ Home page. The Salutation applet greets each user with personalized phrasing 
and targeted information. With the Search applet here and on most screens, 
users can perform full text searches of database records to resolve service issues 
on their own.

■ Literature page. Users can view and download forms and product information.

■ Contact Us hyperlink. Users can send messages to service agents, read messages 
from service agents, and request a virtual meeting over the Web with a service 
agent.

■ Enrollment list. Users can enroll in an insurance plan or review existing 
coverages.

■ Top FAQs list. Users can select from a list of the most common support questions.

■ Announcements list. Users can read the latest news and special offers.

■ Help hyperlink. Users can receive help using the application.

■ Profile hyperlink. Users can edit contact information and passwords.

■ Logout hyperlink. Users click the Logout hyperlink to exit the application.
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Home Page for Siebel eEnrollment for Financial Services 
The home page is displayed to all users, before and after login. When the user first 
navigates to the Siebel eEnrollment application, the home page appears with a login 
applet. A customized home page appears after the user has logged in.

Enrolling for Insurance Coverage
When a customer logs in to Siebel eEnrollment, a list of policies that are currently 
available for enrollment appears. Within a policy there can be a number of options 
that can be selected for enrollment, such as vision, dental, and life insurance 
coverage in addition to major medical. 

Table 19 describes the products and options that customers can specify.

The following procedures describe how to enroll for insurance coverage. 

To add a family member to the list of enrollable members

1 Click the Home tab.

2 Click Begin Enrollment.

The Policy screen appears.

Table 19. Products and Options

Product Options a customer can specify

All Members and effective dates

HMO Primary care physician

PPO Primary care network (corresponds to Facility in Siebel Financial 
Services)

Group Life Beneficiaries

VGL Beneficiaries, and amount for each covered member

401K Beneficiaries
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3 In the Family Members list, click New.

A blank form appears.

4 Complete the fields and click Save.

To enroll yourself or a family member for coverage

1 Click the Home tab.

2 Click Begin Enrollment.

The Policy screen appears.

3 From the Policies Available for Enrollment list, select a policy.

4 Click Select in the Last Name field.

The list of enrollable members appears. See “To add a family member to the list 
of enrollable members” on page 86 for information about adding members to 
this list.

5 Select a member to enroll.

6 If desired, select a primary care physician (PCP).

7 Click Save.

Designating a Beneficiary
Some types of products, such as 401K accounts and life insurance policies, must 
have beneficiaries designated for them as part of the enrollment process.

To name a beneficiary

1 Click the Home tab.

2 Click Review Prior Coverage.

The Prior Policy screen appears.

3 Click Enroll in the Member Selected Products applet for the product you want to 
enroll in.

4 Click New in the Enrollment Elections list.
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5 Complete the fields and click Save.

For more information about naming beneficiaries, see “To enroll yourself or a 
family member for coverage” on page 87.

6 Click Add in the Add Beneficiaries field for the member you are enrolling.

7 Click Enroll Beneficiary in the Beneficiaries applet.

8 Complete the fields.

See “To add a family member to the list of enrollable members” on page 86 for 
information about adding members to the list of people who can be named as 
beneficiaries. 

If multiple beneficiaries will share the proceeds, use the Percentage field to 
indicate the percentage of the proceeds that will go to this beneficiary. The total 
percentage of all beneficiaries must equal 100%.

9 Click Continue.

Administering Enrollees
Before individuals can enroll themselves in policies for which they are eligible, the 
primary enrollee must be associated with a group policy that has a Status of Enforce 
and a Sub Status of Renewal. The value in the Sub Status field is what triggers the 
availability of the Siebel eEnrollment application for that policy. 

Within each organization, someone is designated to enter this information about 
individuals. In smaller organizations, this typically is an owner or officer. In larger 
organizations, this typically is a human resources representative.

Displaying Providers
A provider or contracted provider is a doctor who contracts with a health plan to 
provide care to its members. A provider can be designated as a primary care 
provider (PCP) for one or more products offered by the health plan. Typically, a 
member receives regular health maintenance from their primary provider and 
consults their primary provider before seeing specialists for a health problem.

Members can perform the following tasks:
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■ View profile information about providers

■ Search for providers based on criteria they provide

■ Change their primary care provider

Only providers in the database that are listed as contracted providers for a member’s 
health product are included in the list of providers or in the provider search list for 
that product.

For information about managing providers, see Siebel eHealthcare Guide.

NOTE: There are two screens through which you can search for providers. By clicking 
Locate Nearby Providers on the Home Page screen, you can search for providers, 
but you cannot choose them as your primary care physician. You must follow the 
enrollment process to choose a provider as your primary care physician.
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Literature Page for Siebel eEnrollment for Financial 
Services 

From the Literature page, users can search for and use health insurance-related 
literature such as pamphlets and brochures.

A form must meet the following requirements to be displayed in the Literature view 
or to be a result of a search using the Find Form applet:

■ It must reside in the Siebel file system.

■ Its record in the Literature table must have an Internal field value of FALSE, thus 
allowing external publication.

■ Its record in the Literature table must have a Literature Type field value of Self-
Service Form.

■ It must be associated with the organization to which the Web site visitor is 
associated, that is, the organization of the proxy employee through which the 
user receives data visibility.
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Siebel eCustomer uses a combination of functionality from Siebel eBanking, Siebel 
eSales, and Siebel Insurance eService. It is designed as a comprehensive online sales 
and service application for diversified financial institutions that offer a range of 
product lines.

In Siebel eCustomer for Financial Services, users can access the following user 
interface features. 

■ Home page. The Salutation applet greets each user with personalized phrasing 
and targeted information. With the Search applet here and on most screens, 
users can perform full text searches of database records to resolve service issues 
on their own.

■ Top FAQs list. Users can select from a list of the most common support questions.

■ Contact Us list. Users can send messages to service agents, read messages from 
service agents, and request a virtual meeting over the Web with a service agent.

■ Accounts list. Users can access their accounts from this list.

■ Personal Policies list. Customers can view personal policy details, check the 
status of claims and existing service requests, and submit new service requests.

■ Group Benefits list. Customers can view group benefit details, search for primary 
care providers, and change primary care providers. 

■ Claims list. Users can check the status of claims.

■ Service Requests list. Users can track their service requests.

■ Enrollment list. Users can enroll in an insurance plan or review existing 
coverages.

■ Special Offers lists. Users can view a list of offers.

■ Applications lists. Users can access applications.
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■ Recommended Products lists. Users can access a customized list of products.

■ Help hyperlink. Users can receive help using the application.

■ My Account hyperlink. Users can access personal settings, insurance policies, and 
related screens. The Tools hyperlink provides access to Siebel eSales 
SmartScripts and loan calculators. The Applications hyperlink provides access 
to Siebel eSales applications functionality. The Siebel eBanking hyperlink gives 
users access to personal settings, insurance policies, and other Siebel eBanking 
screens.

■ Logout hyperlink. Users click the Logout hyperlink to exit the application.
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The home page is displayed to all users, before and after login. When the user first 
navigates to the Siebel eCustomer for Financial Services application, the home page 
appears with a login applet. A customized home page appears after the user has 
logged in.
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In the automotive industry, manufacturers want to develop an ongoing relationship 
with customers to increase customer satisfaction and loyalty. Siebel eService for 
eAutomotive allows vehicle manufacturers to create and maintain a relationship 
with customers who have purchased their cars by providing the following features:

■ Anonymous browsing. Unregistered users can view a home page that allows them 
to contact the manufacturer, view top frequently asked questions, search the 
knowledge base, troubleshoot problems, view instructions, ask questions in 
natural language, and view recommended items for sale. 

■ Dealer Locator. Both registered and unregistered users can do a search to locate 
dealers who are nearest to them. 

■ Contact information. Both registered and unregistered users can contact the OEM 
in a variety of ways. 

■ User registration. Users can register and enter information about themselves. The 
information is available to you in the Contacts screen of Siebel eAutomotive. 

■ Vehicle registration. Customers can register vehicles they own that your company 
manufactured. The information is available to you in the Vehicle screen of Siebel 
eAutomotive, associated with the customer’s Contact record.

■ Preventive maintenance. You can set up preventive maintenance plans for the 
makes of vehicles that you manufacture, and customers can use Siebel eService 
for eAutomotive to see upcoming maintenance actions for their vehicles. 

■ Online service requests. If customers’ cars need service, they can enter service 
requests on line, and they have the option of routing a service request directly 
to a dealer. A dealer will contact them to make an appointment. 

■ Online inventory search. If customers want to buy a specific make, model and year 
car, they can search the inventory of your dealers to see which dealers have the 
car they want. 
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■ Online service history. Customers can display their past service history. 

■ Online order status. Customers can check the status of their orders. 
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Overview of Differences Between Siebel eService and 
Siebel eService for eAutomotive

The most important differences between Siebel eService and Siebel eService for 
eAutomotive are:

■ Audience. Siebel eService Administration Guide is aimed generally at any 
company that provides service through the Web. Siebel eService for eAutomotive 
is aimed specifically at manufacturers or OEMs in the automotive industry.

■ Cross-references. Siebel eService Administration Guide often refers the reader to 
Applications Administration Guide for more information. For Siebel eService for 
eAutomotive, in addition to this book, the reader should see Siebel eAutomotive 
Guide. 

■ Differences in the Siebel eService Portal. The portal that the customer views has 
many added and modified features aimed specifically at automobile customers. 

■ Differences in Administering Siebel eService. The added or modified features of the 
customer portal generally requires added or modified administrative tasks. 

The rest of this document will detail the differences in the customer portal and any 
differences in administration that they require. 
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Home Page and Global Buttons for Siebel eService for 
eAutomotive

The Siebel eService home page allows new users to register and provides both 
anonymous and registered users with links to more information. 

The home page of Siebel eService for eAutomotive has the following differences 
from Siebel eService:

■ Link to the dealer locator. The Contact Us applet has a link to the dealer locator 
instead of a link to the branch locator. 

■ Link to register a vehicle. The My Account applet includes a link to register a 
vehicle instead of a link to register a product. 

■ Link to My Service History. The home page has a link to My Service History, which 
is unique to eAutomotive. 

■ Link to My Vehicles. The home page has a link to My Vehicles, which is unique to 
eAutomotive. 

Global buttons are visible when the user displays any page of Siebel eService. The 
following global buttons have different functions in Siebel eService for 
eAutomotive:

■ My Account. Displays the My Account view. Differences from the My Account 
view of Siebel eService are discussed in “The My Account View of Siebel 
eService for eAutomotive” on page 104.

■ Contact Us. Displays the Contact Us view, which lists a number of ways of 
contacting the OEM, including email, postal mail, fax, and a feedback form, 
telephone, and direct collaboration with a customer care representative. Differs 
from Siebel eService because the Contact Us view of Siebel eService for 
eAutomotive contains a link to the Dealer Locator, instead of a link to the Branch 
Locator. 

■ Inventory Search. Displays Inventory Search view, which is unique to Siebel 
eService for eAutomotive. This view is discussed in “Activating Vehicle 
Registration Workflows” on page 101. 
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These changes in the home page and global buttons may be important to you if you 
are configuring Siebel eService. 

For more information about configuring Siebel eService, see Siebel eService 
Administration Guide. 

NOTE: To make the eService for eAutomotive home page visible to customers, you 
must configure the application using Siebel Tools. After you configure the 
application, this home page will appear when the customer clicks the Service 
button in eCustomer as well as when the customer logs into eService. For 
information about making the home page visible to customers, see the Release Notes 
document for your Siebel application.
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New or existing customers can use the Dealer Locator to find the dealer nearest to 
them, so they can purchase or get service for a vehicle. 

Both anonymous and registered users can use the Dealer Locator by clicking the 
Locate Nearby Dealer link on the home page or by clicking the Contact Us Global 
button and then clicking the Locate Nearby Dealer link. 

Customers enter the following information:

■ Location. Customers enter either their ZIP code or their city, state and country. 

■ Category. Customers use the Category drop-down list to specify whether they 
want a dealer, a service center, or either. 

■ Make. Customers use the Make drop-down list to specify the make of car. 

■ Search Range. Customers use the Distance In (miles or kilometers) and Search 
Range fields to specify how far from their location the dealer may be. 

When the customer clicks Search, the result includes all dealers that meet the 
criteria that were entered. 

The Dealer Locator searches through all the dealers that you have entered in the 
Dealer Locator Administration view in eAutomotive. 

For more information about entering dealers in the Dealer Locator Administration 
view, see the section about Siebel eAutomotive tools in Siebel eAutomotive Guide.
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Activating Vehicle Registration Workflows
Before customers can use Siebel eService for eAutomotive to register their vehicles, 
you must activate the vehicle registration workflows. 

To activate vehicle registration workflows

1 From the application level menu, choose View > Site Map > Runtime Events 
Administration > Events.

2 Do a query for the value *eAuto*Reg* in the Object Name field. 

3 If the query displays any records, delete them all and continue with the next 
step. If the query does not display any records, continue with the next step. 

4 From the application level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes. 

5 Do a query for the value eAuto Vehicle-Reg* in the Business Object field. 

Several records should be displayed. 

6 Make sure all these records are active by looking at the Status field to see if it 
has the value Active. 

7 If any record is not active, select it and click Activate. 

The status of the record is changed to Active. 

After the status of every record is Active, customers can proceed with vehicle 
registration.
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Inventory Search for Vehicles 
Potential customers may find exactly the vehicle that they want by using your Siebel 
eSales Web site, by looking at your marketing material, or in some other way. Then, 
because virtually all vehicle sales are through dealers, they will want to see whether 
any dealers near them have that vehicle in their current inventory. 

Both anonymous and registered users can use the Inventory Search view by clicking 
the Inventory Search global button. 

Customers enter the following information:

■ Their location. If they want the vehicle at the nearest dealer, customers can enter 
either their ZIP code or their city, state, and country. 

■ New/Used Type. Customers use the drop-down list to specify whether they want 
a new or used car. 

■ From/To Model Year. If they want a used car, customers use these fields to specify 
the range of years they are interested in. 

■ Make. Customers use the drop-down list to specify the make of car they are 
interested in. 

■ Model. Customers use the drop-down list to specify the model of car they are 
interested in. 

■ Trim. Customers use the drop-down list to specify the trim they are interested in. 

■ MSRP Less Than. Customers enter the maximum price they want to pay. This field 
applies to both new and used cars. The price is taken from the MSRP field of the 
Vehicle record. 

■ Mileage Less Than. If they are buying a used car, customers can enter the 
maximum mileage they want on the car.

■ Search Range. If they want the vehicle at the nearest dealer, customers can use 
the Distance In (miles or kilometers) and Search Range fields to specify how far 
from their location the dealer may be. 
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When the user clicks Search, the result includes all vehicles that meet the criteria 
that were entered. 

NOTE: For inventory search to work properly, you must enter only one location for 
each dealer in the Dealer Locator Administration screen. If you have multiple 
locations for one dealer, the inventory search may not function properly, because a 
vehicle is tied to a dealer, not to a dealer location.

The inventory search uses information that you entered in the Vehicle screen of 
eAutomotive. For a vehicle to be available in a dealer’s inventory, it must have the 
following values entered in these fields of the Vehicle form: 

■ Status field: Available

■ Owned By field: Dealer 

■ Account field: the dealer name 

For more information about making a vehicle available in a dealer’s inventory, see 
the section about Siebel eAutomotive Tools in Siebel eAutomotive Guide.
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The My Account view is a central location with links to all the personalized 
information of a registered user. Registered users can display it by clicking the My 
Accounts global button, which is not available to unregistered users. Customers can 
use the My Account view as a dashboard that lets them access all their information 
in Siebel eService. 

The My Account view is very different in Siebel eService for eAutomotive than in 
Siebel eService. 

The My Information applet in the My Account view includes the following links:

■ My Vehicles. Displays the My Vehicles view with a list of all the customer’s 
vehicles, as described in “The My Vehicles View of Siebel eService for 
eAutomotive” on page 106. 

■ Register New Vehicle. Allows the customer to register a new vehicle as described 
in “Vehicle Registration” on page 105. 

■ My Service Requests. Displays the My Service Requests view with a list of the 
customer’s service requests, as described in “Service Requests in Siebel eService 
for eAutomotive” on page 109. 

■ My Service History. Displays the Service History view as described in “Service 
History” on page 110. 

■ My Orders. Displays the customer’s pending orders with information about the 
status of each order. 

The My Company’s Information applet is similar to the My Information applet. It 
includes links to My Company’s Service Requests and My Company’s Orders, which 
are similar to the corresponding links in the My Information view, except that they 
display lists of all data associated with the customer’s company. A customer can 
have multiple accounts, so you must choose the appropriate account before you can 
see the relevant information. 

The My Settings applet is similar to the My Settings applet in Siebel eService. It lets 
customers enter or modify their user profile, address book, and subscriber 
preferences. 
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Vehicle Registration 
Customers can use Siebel eService for eAutomotive to register their vehicles. You 
can find this information about the user in the Contacts screen of Siebel 
eAutomotive, and you can use it for follow-up marketing and service. 

For more information about working with contacts and associated vehicles, see 
Siebel eAutomotive Guide.

A registered user of Siebel eService for eAutomotive can register a new vehicle by:

■ Clicking the Register New Vehicle link in the My Accounts View

■ Clicking New in the My Vehicles list

■ Clicking the Register New Vehicle link in the home page 

The user must begin by entering the VIN#. If the entry matches a VIN# in the 
database, the user can continue. If the entry does not match a VIN# in the database, 
the user cannot continue, because it is not one of your vehicles. 

After the user enters a valid VIN#, the Make, Model, Year, and Trim fields are 
populated automatically with information from the Vehicle record. The user enters 
personal information, which is stored in the record of the primary contact 
associated with that vehicle. If there is already a primary contact for a vehicle, the 
customer cannot register that vehicle. 

NOTE: Before customers can use vehicle registration, you must activate registration 
workflows. For information about activating workflows, see the Release Notes 
document for your Siebel application.
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The My Vehicles View of Siebel eService for eAutomotive
Users display the My Vehicles view by clicking the My Vehicles link in the My 
Account view. The My Vehicles view lists all the vehicles for which the user is the 
primary contact.

My Vehicles view displays a list of all the vehicles registered with the customer as 
a primary contact. The customer can click on a VIN# in the Vehicles list to display 
a form applet with information about that vehicle plus three lists: 

■ PM Actions list. Preventive maintenance actions for that vehicle and when each 
is scheduled discussed in the section “Preventive Maintenance” on page 107. 

■ Service History list. The service history for that vehicle discussed in the section 
“Service History” on page 110. 

■ Attachments list. Attachments for that vehicle. The customer can add and view 
attachments here. The OEM can add and view attachments in the Attachments 
view of the Vehicle screen of Siebel eAutomotive. 
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Preventive Maintenance
The OEM can set up regular schedules of preventive maintenance for vehicles. 

For example, one make of vehicle might require basic maintenance, such as 
replacing the oil filter and changing the oil, every 3,000 miles or three months, 
whichever comes sooner. The vehicle may also require more extensive 
maintenance, such as replacing spark plugs, at 30,000 miles or three years after 
purchase and at 60,000 miles or six years after purchase, whichever comes sooner. 
These schedules may be more frequent if the vehicle is driven in demanding 
conditions. In addition, the vehicle may require preventive maintenance if its oil 
pressure is low, its coolant temperature is high, or it has other specific problems. 

By default, Siebel eService for eAutomotive allows customers to view a list of 
preventive maintenance actions for their vehicles. 

The customer displays preventive maintenance actions by going to the My Account 
view of Siebel eService for eAutomotive, described previously, and clicking the My 
Vehicles link. The My Vehicles list appears, and the user can click the VIN# of any 
vehicle to display a My Vehicles form, with information about that vehicle, and a 
PM Actions list with all coming preventive maintenance actions for that vehicle. The 
customer can update the time and odometer reading when he or she has completed 
the action. 

Visibility of Preventive Maintenance Actions to the Customer
To allow the customer to display preventive maintenance actions, you must:

■ Create preventive maintenance plans. 

■ Set triggers for preventive maintenance plans. 

■ Associate the preventive maintenance plan with a vehicle model and with a 
specific vehicle. 

For information about how to do these things, see the chapter about preventive 
maintenance in Siebel eAutomotive Guide. 
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Sharing Preventive Maintenance Documents with Customers
You can share preventive maintenance documents with customers by adding the 

documents as attachments to preventive maintenance plans in Siebel eAutomotive. 
For example, you can create a document with detailed instructions for servicing the 
automobile, and attach it to the appropriate preventive maintenance plan. 

Then, customers who use that preventive maintenance plan can display the 
document by clicking a preventive maintenance action in the Actions list in Siebel 
eService for eAutomotive, to display a form with detailed information about the 
action and a list of attachments. The customer can click on any attachment in the 
list to download and display the document. 

To share a preventive maintenance document with a customer

1 From the application-level menu, choose View > Site Map >Preventive 
Maintenance >Preventive Maintenance.

2 In the Plans list, select the record for the plan that the document applies to.

3 Click the Attachments view tab. 

4 In the Attachments list, click New.

A new record is added to the list. 

5 In the Attachment Name field of the new record, click the select button. 

6 In the Add Attachment dialog box, click the Browse button. 

7 In the Choose File dialog box, select the file that you want to add as an 
attachment and click Open.

8 In the Add Attachment dialog box, click Add. 

The file is added as an attachment to the plan. 
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Service Requests in Siebel eService for eAutomotive
A service request might involve a problem with a vehicle, such as squeaking brakes, 
it might be a request to add new accessories to the car, or it might be a request for 
information. 

In the automotive industry, dealers generally handle service requests. Siebel 
eService for Automotive allows the customer to route service requests directly to a 
dealer. If the customer does not do this, the OEM must route the service request to 
the appropriate dealer, so the dealer can contact the customer and make an 
appointment to fulfill the service request. Certain types of service requests, such as 
requests for information, can be routed to the appropriate department of the OEM 
for fulfillment. 

Customers can enter service requests by going to the My Account view, clicking the 
My Service Requests link, and clicking New in the My Service Request list. 

Service requests in Siebel eService for eAutomotive have a number of 
enhancements that are specific to the automotive industry:

■ VIN#. While entering the service request, the customer clicks the select button 
of the VIN# field to select the vehicle that the service request applies to, allowing 
you to view full information about this vehicle. 

■ Mileage. The customer uses the Current Mileage and Unit fields to enter the 
mileage of the vehicle and specify whether the unit of measure is miles or 
kilometers. 

■ Dealer. The customer can click the select button of the Assigned Dealer field to 
select a dealer that the service request will be assigned to. The customer is not 
required to make a selection in this field. 

■ Services to Be Performed. The customer can specify the services to be performed 
as part of this service request. 

■ Appointment Time. Customers can specify the time and date when they want the 
service to be performed. 

You can set up Siebel Assignment Manager to assign service requests based on the 
type of service request, dealers’ locations, the makes of vehicle that dealers handle, 
dealers’ special skills and other criteria. For more information, see Siebel 
Assignment Manager Administration Guide. 
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For more information about service requests, see the chapter about service requests 
in Siebel eAutomotive Guide. 

Service History
To allow customers to keep track of the services performed to their vehicles, Siebel 
eService for eAutomotive provides the Service History view as an addition to Siebel 
eService. 

Customers can click the My Service History link in the My Account view to display 
the Service History list, which includes all of their past service history. They can 
also click the VIN# in the My Vehicles view to display a Vehicle form and Service 
History list for a specific vehicle. 

In the Service History list, they can click the SH# field of any service history in the 
list to display a Service History form with information about that service history and 
a Services Performed list with all of the actions taken to respond to the service. 

Service History records could be imported from the dealer’s Dealer Management 
System (DMS). Alternatively, customers could add the service history themselves, 
by clicking the New button of the Service History list in Siebel eService for 
eAutomotive. 

For more information, see the chapter about service history in Siebel eAutomotive 
Guide. 
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Siebel eService for Communications, Media, and Energy is a Web portal that allows 
your customers to: 

■ Submit and track service requests 

■ Track the status of orders 

■ Manage products through their life cycle 

■ Search a knowledge base for solutions to frequently asked questions and for 
other information 

■ Troubleshoot problems using interactive guides 

■ Locate your nearest retail or service location 

■ Collaborate with service agents in real time by sharing Web pages, documents, 
and other desktop information 
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Features Specific to Siebel eService for 
Communications, Media, and Energy

There are several differences in Siebel eService that are related to the complex 
accounts and complex orders that are used in the communications, media, and 
energy industries. These differences include: 

■ Differences in the customer portal 

■ Differences in personalization 

Differences in the Customer Portal for CME
Siebel eService Administration Guide describes the portal that customers use to 
access Siebel eService. 

The Siebel eService customer portal for Communications, Media, and Energy has a 
number of differences from the Siebel eService customer portal. The most important 
differences are:

■ Support for complex account management

■ Support for complex orders that include products and services

NOTE: Service requests are also known as trouble tickets in the Communications 
industry. The term trouble ticket is used in Siebel eCommunications for internal, 
agent-facing applications, but the term service request is used in the customer 
portal, because people who use the product through the Web might not be familiar 
with this industry-specific terminology. Service requests submitted through the 
customer portal can be viewed in Siebel eCommunications client by displaying the 
All Trouble Tickets view.
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Support for Complex Account Management
In the communications, media, and energy industries, it is common for a single 
customer to have multiple accounts, representing different types of service at 
different locations. For example, a customer may have accounts for its electric and 
gas service at a number of locations. 

For this reason, Siebel eCommunications and Siebel eEnergy allow you to define 
complex account hierarchies. For example, you might define a parent account for a 
customer’s business, separate child accounts for each utility service at each of the 
customer’s sites, and several billing accounts to be billed for the service at different 
groups of sites. For more information about account hierarchies, see the section 
about accounts in Siebel eCommunications Guide or Siebel eEnergy Guide.

NOTE: For a contact to have visibility to an account, either the Proxy Employee value 
specified in the .cfg file for eService, eSales and eCustomer, or the login name 
specified in the Employee Login Name field in the User list of the User 
Administration screen must be one of the names in the Account Team field of that 
account's Account record. 

The My Account screen allows customers to work with multiple accounts. 

Customers click the current account link of the My Account screen to display the 
current account view, which includes information about their current account and 
a Select Account list that includes all of their accounts. They can use this Current 
Account view to:

■ Change the current account. Customers can use the Current Account list at the 
bottom of the screen to select the current account. Siebel eService displays 
service requests, billing information, and other information for the current 
account. 

■ Select the primary account. Customers can use the Primary Account list at the 
bottom of the screen to select the primary account. 

■ Add new accounts. Customers can click the Create New Account button to create 
and enter information about a new account. 

■ Add new addresses. Customers can click the Add button of the Current Account 
Address list to add new addresses for the current account. 
Version 7.5.3 Siebel eService Administration Guide Addendum for Industry Applications 113



Siebel eService for Communications, Media, and Energy

Features Specific to Siebel eService for Communications, Media, and Energy
Support for Complex Orders Including Products and Services
In the communications, media, and energy industries, it is common for customers 
to place complex orders, which include products and services. For example, a 
customer might order a cell phone and cell phone service. The cell phone may have 
a warranty that expires after a year, while the cell phone service continues until the 
customer ends it.

For communications, media, and energy, Siebel eService for Siebel Industry 
Solutions supports these complex bundles of products and services. 

For communications, media, and energy, the Siebel eService for Siebel Industry 
Solutions home page has a link named My Products and Services, instead of the 
Register My Product link on the Siebel eService home page. There is also a Products 
and Services applet in the My Account screen. These features allow the customer to 
view information about the products and services for the account that they are 
currently logged in under. 
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Differences in Personalization for CME
There are some changes in personalization for customer applications to support the 
fact that a single contact can have multiple accounts in communications, media, 
and energy. 

Any account-specific personalization rules are evaluated using the contact’s 
primary account. 

When the contact logs in, the login process loads the contact's primary account's 
profile into memory. When the contact selects an account, it does not flush the 
primary account’s profile out of memory and load a new one. It only changes the 
values of four profile attributes, as shown in Table 20.

This behavior cannot be changed, so account-driven personalization rules will 
always use the contact’s primary account. 

However, if you want to use a specific field value of the current account for 
personalization, you can write Siebel VB code to get the field value from the 
account. When the user selects an account, the system sets two global variables that 
can be accessed using Siebel VB:

■ AccountId

■ AccountName

To access these variables, use the InvokeMethod event, and use the SetProfileAttr 
method to set a dynamic profile attribute.

For more information about personalization, see Personalization Administration 
Guide. 

Table 20. Profile Attributes Changes When a Contact Selects an Account

Attribute Name Value

SessionAccountId ROW_ID

SessionAccountName NAME

CustomerAccountId MASTER_OU_ID

DefaultPriceListId CURR_PRI_LST_ID
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